CHAPTER II

LITERATURE REVIEW

A. Grammar

1. The Definition of Grammar

Grammar has various meanings. Harmer (1987: 12) states that grammar is the description of the ways in which words can change in that language and can be combined into sentences in that language. Thus, grammar is the study of words into a large order (morphology and syntax) that relate each other so that the large order can give information to the reader and listener. It must be aware of grammar since it deals with not only words but also the formation of words into a large order and also its meaning. Moreover, according to Thornbury (2004: 40), grammar describes the way language is organised and patterned – particularly at the level of the sentence – in order to make meaning.

Based on the definition above, it can be concluded that grammar is a part of the language and it consist of the pattern in which word of language are arranged so.

2. The Importance of Learning Grammar

The importance of grammar are as follows:

a. Grammar is important to be taught because it affects to students’ performance in all four skills; reading, listening, reading and writing.

THE EFFECTIVENESS OF JEOPARDY …… SHEILLIA OCTA ANGGRAENI, FKIP UMP 2013
b. Grammar and language cannot be separated from one another and language is not meaningful.

c. Students are expected in comprehending English either written or spoken. That is why, knowing the system rule of grammar of a target language fluently and acceptably.

Based on the description above, it can be concluded that grammar is important element of the language related with forming sentence in communication, both written and spoken because it can control students’ English in making sentence correctly. Grammar consists of rules of principle that can help to identify correct sentences so that communication will run well; the receiver or listener can catch the information which is given by the sender or speaker.

According to Thornbury (2004: 40), grammar also has a social function; the particular grammar that is adopted, like particular accent, distinguishes as part of a social group. That is why so much ink is expended on issues like fewer vs. Less; as in There were fewer/less people here than last time, and pronouns; as in He is taller than I/me. Here there is no question of ambiguity. That statement is clear that learning pronoun is certain thing and important to be taught.
B. Pronoun

1. The Definition of Pronoun

According to Beech (2007: 120), a pronoun is a word that takes the place of a noun. A pronoun is a word that names a person, place, or thing. The purpose of using pronouns are to avoid from repeating itself. By using pronouns, it is not needed to repeat the same nouns over and over again. Therefore, pronouns make reading, writing and speaking clearer, less repetitive and more varied. A singular pronoun takes the place of a singular noun. A plural pronoun takes the place of a plural noun.

2. Kinds of pronoun

There are several pronouns: Personal, Possessive, Reflexive, Relative, Demonstrative, Interrogative, Indefinite, and Reciprocal.

However, in this case, it will be explained about three types of pronouns. They are personal pronoun, possessive pronoun and reflexive pronoun.

a. Personal Pronoun

According to Bakir (2011: 30), a personal pronoun is pronoun that replaces a person or thing. In sentences, this pronoun is used as a subject and an object. Those differences can make changing of form.

Whereas, according to Noor (2003: 27), A personal pronoun replaces:
• the subject of a sentence (it is called the subject pronoun)

• the object of a sentence (it is called the object pronoun)

The personal pronoun in the subject form in the current English are: I, you, he, she, it, we, and they. Then for the object form: me, you, him, her, it, us, and them. The personal pronoun changes their form for person (first, second, third), for case (subject, object), number (singular, plural) and gender (masculine, feminine, neuter).

Personal pronoun are formed in table 2.1

Table 2.1
The form of personal pronoun

<table>
<thead>
<tr>
<th>Number</th>
<th>Person</th>
<th>Personal Pronoun as Subject</th>
<th>Personal Pronoun as Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Singular</td>
<td>First person</td>
<td>I</td>
<td>Me</td>
</tr>
<tr>
<td></td>
<td>Second person</td>
<td>You</td>
<td>you</td>
</tr>
<tr>
<td></td>
<td>Third person</td>
<td>He / She / It</td>
<td>him / her / it</td>
</tr>
<tr>
<td>Plural</td>
<td>First person</td>
<td>We</td>
<td>Us</td>
</tr>
<tr>
<td></td>
<td>Second person</td>
<td>You</td>
<td>you</td>
</tr>
<tr>
<td></td>
<td>Third person</td>
<td>They</td>
<td>they</td>
</tr>
</tbody>
</table>
The table above explains for several points;

1) Using personal pronouns to replace nouns when it is clear who or what are talked about:

a) Using subject pronouns as the subject of verb.

A subject pronoun replaces the subject of a sentence. The subject of a sentence tells who or what the sentence is about. Usually the subject of a sentence is a noun.

The subject can also be a pronoun.

Examples:

Silvana didn’t go to school, She went to Bali. (She = Silvana)

Where are Mark and Shane? They are playing football. (Mark and Shane = They)

b) Using object pronouns as the object of verbs and prepositions.

An object pronoun is a word that replaces the object of a sentence. Pronoun as an object usually follows action verbs and prepositions. Object pronouns must reflect the nouns that they replace.

Examples:

Dyla gives him a guitar. (gives = verb + him)

Bryan meets her on the bus. (meets = verb + her)
Examples:

Indra gives greeting card to me. (to = preposition + me)

Dimas and Wildan are waiting for us. (for = preposition + us)

2) Using each pronoun for different person.

a) I/me : for the person speaking

b) We/us : for the person speaking and another person or other people

c) You : for the person or people spoken to

d) He/him : for a male person

e) She/her : for a female person

f) It : for a thing or for an animal

g) They/them : for people or things

Notes:

1. Never use subject pronouns after action verbs.

Don’t write:

Uncle Dan taught Joan and I.

Write:

Uncle Dan taught Joan and me.

2. The pronouns you and it can be used anywhere in a sentence.
b. Possessive Pronoun

A possessive pronoun is used to show that something belongs to a person or an animal. According to Bima and Kurniawati (2012:73), possessive pronouns are used to talk about things belonging to people. Possessive pronoun can stand on their own and not followed by nouns.

In a sentence, its use can be divided into possessive adjectives and possessive pronouns. It is called possessive adjective because that possessive function as adjectives.

The table 2.2 is shown how possessive pronouns are used.

Table 2.2
The form of possessive pronoun and possessive adjective

<table>
<thead>
<tr>
<th></th>
<th>SINGULAR</th>
<th>PLURAL</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Possessive Adjective</td>
<td>Possessive Pronoun</td>
</tr>
<tr>
<td></td>
<td>(before a noun)</td>
<td>(without a noun following it)</td>
</tr>
<tr>
<td>1st person</td>
<td>my . . .</td>
<td>mine . .</td>
</tr>
<tr>
<td>2nd person</td>
<td>your . .</td>
<td>yours . .</td>
</tr>
<tr>
<td>3rd person</td>
<td>his . . .</td>
<td>his . .</td>
</tr>
<tr>
<td></td>
<td>her . .</td>
<td>hers . .</td>
</tr>
<tr>
<td></td>
<td>its . .</td>
<td>its .</td>
</tr>
</tbody>
</table>

(Bima and Kurniawati, 2012: 73)
Examples:

(P. Adjective ⇒ P. pronoun)

This is my shawl. ⇒ This is mine.

The lady mistakenly took their luggage. ⇒ the lady mistakenly took theirs.

1) Using possessive adjective before a noun to say who the noun belong to:

Examples:

Dian changes her shoes, (Her = Dian)

Arif tells his story, (His = Arif)

2) Using a possessive pronoun without a noun, when the noun is understood.

Examples:

This book is yours. (your book)

These cakes are ours. (our cakes)

c. Reflexive Pronouns

Reflexive pronoun is a pronoun which has suffix –self or –selves. They are myself, himself, herself, ourselves, themselves, itself.

Those suffixes above meant alone, (Suroso, 2009: 27).

Reflexive Pronoun is formed in table 2.3.
Table 2.3

The form of reflexive pronoun

<table>
<thead>
<tr>
<th>Number</th>
<th>Person</th>
<th>Reflexive Pronoun</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>First person</td>
<td></td>
</tr>
<tr>
<td>Singular</td>
<td>my + self</td>
<td>myself</td>
</tr>
<tr>
<td></td>
<td>your + self</td>
<td>yourself</td>
</tr>
<tr>
<td></td>
<td>him + self</td>
<td>himself</td>
</tr>
<tr>
<td></td>
<td>her + self</td>
<td>herself</td>
</tr>
<tr>
<td></td>
<td>it + self</td>
<td>itself</td>
</tr>
<tr>
<td>Plural</td>
<td>First person</td>
<td>ours + selves</td>
</tr>
<tr>
<td></td>
<td>your + selves</td>
<td>ourselves</td>
</tr>
<tr>
<td></td>
<td>them + selves</td>
<td>themselves</td>
</tr>
</tbody>
</table>

A reflexive pronoun is used:

1) to refer to a noun or a personal pronoun which is both the subject and the object of a sentence (the subject and the object refer to the same noun or pronoun).

*Note: when the reflexive pronoun is used in this way, it is written after the verb.*

Example:

Lily looked at **herself** in the mirror and said, “I need a haircut.”

⇒ **herself** refers to the subject Lily.
When sticky seeds hooked **themselves** to his trousers, the inventor...

⇒ **themselves** refers to the subject **seeds**.

2) To emphasize the subject (noun or personal pronoun) in a sentence or if the subject needs stresses. The subject performs the action without assistance. The position of reflexive pronoun can be after the subject or at the end of sentence.

*Note: when the reflexive pronoun is used in this manner, it is written after the subject or object.*

Example:

**I myself** teach my children English

⇒ **I** (the subject) perform the action (teach) alone.

**He** invented the transistor radio and many other gadgets **himself**.

⇒ **He** (the subject) performed the action (invented) alone.

**My brother** learned to play the guitar **himself**.

⇒ **My brother** (the subject) performed the action (learned to play the guitar) alone.
C. Jeopardy Game

Jeopardy is one of active learning and it is like game / quiz show that has categories and points. In each point contains of clue/question that should be answered by the students. The points or questions are based on level of difficulty. Usually, this game is played for reviewing or assessing session. To understand more about Jeopardy game, it must be known about the benefit itself first.

1. The Benefits of Using Jeopardy Game in Classroom

   Jeopardy is like game / quiz show that has categories and points. This game will help students to be better retain information. Students will love to impress colleagues with knowledge, getting feel like real contestants on the television program “Jeopardy”. (Nicolai, 2012).

   Moreover, according to Rotter (2004: 58), using this game format allows the teacher to assess knowledge without the need for formal tests or to reinforce critical information while avoiding rote practice. Then, this game also allows for adaptation of the questions to any content area and levels of awards based on the difficulty of the question answered. This format also provides some accommodation for the variety of skill levels found within every classroom.

   Besides the benefit of that game, it also has the weakness of using jeopardy game.
2. The Weaknesses of Using Jeopardy Game in Classroom

According to Churton, et. al in Rotter (2004: 58), this game also has the weaknesses, especially for the students because the students:

a. Need significantly more time for learning.

b. Have difficulties with attention, including failure to attend to relevant stimuli and difficulty sustaining attention.

c. Have memory problems, including failure to use rehearsal and other memory-enhancing strategies spontaneously.

d. Have difficulty organizing and completing tasks independently; pupils who do not know the answer to most of the “jeopardy” questions may be embarrassed by their lack of knowledge or may choose to “zone out” or misbehave.

Generally, when jeopardy is played, the students either know or do not know the answers. As the result, only those students who have already studied and learned the content are likely to earn points.

From the weaknesses mentioned previously, there are solutions to help students’ success in jeopardy game, (Rotter, 2004: 59-61).

First, encourage the students to take notes and use them to study ahead; explicity teach students to prepare their notes for the jeopardy game before the day of the game.

Second, announce games in advance, and support the students in their preparation; the students use the strategy by acronym “BEST”, for “Break
the assignment into parts, Estimate the number of study sessions needed, Schedule the sessions, and Take the materials home.

Third, support the game with the use of content enhancers for recall; content enhancers can help students identify, organize, comprehend, and retain critical content information.

Fourth, play it twice; to evaluate the students’ acquisition of information from the game, the teacher should evaluate the students’ performance on several rounds.

In delivering this game, there are several media that can be used, for example by board, powerpoint’ slide, or even just use paper. In this case, it is used “PowerPoint” as a media. PowerPoint, Microsoft’s software that comes with their Office Productivity Suite, has been used for educational purposes since its inception. One of the most popular ways for teachers to use PowerPoint has been to make a Jeopardy-style trivia game using the program’s slideshow mode.

To use this technique easier, it should know and understand of making Jeopardy game in PowerPoint.

3. Instructions for making Jeopardy game in PowerPoint

Many users, however, do not know how to achieve this game show effect using PowerPoint. Luckily, making and playing a Jeopardy-style game in PowerPoint is an easy process, requiring only a few simple steps.
The instruction for making Jeopardy game is PowerPoint are as follows, (Poirier, 2012):

a. Create a new PowerPoint document. Click the “Format” tab from the application menu and select “Background” from the menu to choose the background color for slides. Choose the font style and size that will be used in Jeopardy game from the font menu and click “Apply”.

b. Click the “Insert” tab and select “Table” from the menu. Make the table into five columns and six rows and click the “OK” button. Click and drag the corner of the table to make it fill the slide.

c. Insert a category name into the top row slot of each column. Going down each column, insert the point values 10, 20, 30, 40, and 50, each in a separate box. The table should now resemble a Jeopardy game board.

d. Click the “Insert” tab and select “New Slide” from menu. Type a question on the blank slide. Create another new slide and type the answer to the question.

e. Return to the game board slide. Highlight the point value that is wished the question that has written in Step 4 to be worth. Click the “Insert” tab and select “Hyperlink”. Click the “Place in This Document” option from menu. Click on the question slide that has created in Step 4 and press “OK” button to link the value on the game board to the question.

f. Go to answer slide that has created in Step 4 and use the Hyperlink process that has used in Step 5 to link the answer slide text to the game.
board slide. This will allow the player to easily return to the game board slide after every question.

g. Repeat Step 4, 5 and 6 for every point value on the game board slide.

h. Play the game as a normal slide show. Click on the point values to reveal questions. Click on the answer text to be taken back to the game board.

D. Teaching Personal, Possessive and Reflexive Pronoun Using Jeopardy PowerPoint Game

Facing the students to study material is often frustrating and challenging, lack of interest becomes more and more apparent as class time goes by, with students slouching at their desks and staring at the clock, many teachers overcome this problem by incorporating classroom material into engaging trivia games, as a Jeopardy. Jeopardy contains of categories and points. Then, because it uses PowerPoint as media so in this case, it is used jeopardy powerpoint game for teaching personal, possessive and reflexive pronoun. To understand more about the implementation of jeopardy powerpoint game in classroom, it must be known about the procedures of this game.

1. The Procedure of Using Jeopardy Powerpoint Game

This strategy is designed like a polular game show on television, the answer that is given, and its challenge is bring or answer correctly. The form can be used easily as a material review, (Silberman, 2009: 248).
The procedure in playing Jeopardy Game are as follows, (eHow Contributor: 2012):

a. Materials: clue or questions prepared ahead of time the students to answer; the question list is based on the difficulty level (prepared in PowerPoint), captains (to choose point in each category), some pieces of paper, pen, scorekeeper (it may be the teacher if the teams are even).

b. Preparation

✓ Divide the students into four groups for a classroom
✓ Explain the rules

c. Rules

1) Individual work:

   a) Each group must has a captain to choose the value of each category then click on the slide, read the question. The question that have been chosen obtained to other team too.

   b) Each student in each team should have chance to answer the clue/question (work individually), so the candidates sit on the first desk in place of each group. Make it in turn.

   c) Students have only one chance to answer a question.

   d) Allow them 5 seconds to think and write their answer on piece of paper.

   e) After time is up, their answer in piece of paper is shown together.
f) The student should guess the answer in term of question.

g) Deduct points for incorrect answer.

h) The team which gets more points for the answer is the winner.

2) Final Jeopardy (Group work):

a) Discuss and find out the answers from each question. Kind of question is variety, for example replacing noun to pronoun, filling in the blank, translating, etc.

b) Allow the students 10 seconds to think and write their answer on piece of paper.

2. The Example of Using Jeopardy Powerpoint Game

The example of using jeopardy powerpoint game are formed in figure 2.1

Figure 2.1
Example of Jeopardy Game Slide

<table>
<thead>
<tr>
<th>category</th>
<th>PERSONAL PRONOUN</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 / Me</td>
<td>They/ them</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>We / us</td>
<td>You / it</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>You / it</td>
<td>He/ Him She/ Her</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

Group work
The figure above describes about jeopardy powerpoint game in personal pronoun, here the captain chooses one of points in a category, for example he/she chooses point 10 in category “I / Me” so by hyperlink mode, it will display a clue or question of that point. (see figure 2.2)

In the figure 2.2, the candidates (representative of each team) should answer the clue/question. Then, write the answer on piece of paper. After that, the teacher click on the question slide, click at the top or anywhere on the page to get the answer.

The answer is formed in figure 2.3.

---

**Figure 2.2**

**Question Slide**

___ will read some novels tomorrow.

---
The last step, click on the to return to the category page. (For more detailed about the slides, see appendix on lesson plan of experimental class).

In teaching personal, possessive and reflexive pronoun by using jeopardy powerpoint game, the students can change noun to pronoun or conversely. It caused most of questions on the slide are about the changes of noun to pronoun. Besides that, the students also can choose the appropriate pronoun. This statement can be proved and seen from the result of assessing in treatment and from students’ score of post test.
E. Basic Assumption

Pronouns are words that take the place of common and proper nouns in a sentence. No matter how simple this seems, getting students to understand and be able to apply this knowledge is not always easy. Thus, it used jeopardy powerpoint game as a media in teaching personal, possessive and reflexive pronoun. The game show “Jeopardy!” is meant to test people’s knowledge. This game is like game show that has categories and points. Each point contains question and should be answer by the students or candidates. If the student can answer correctly, the team will get the point, if not, the team will deduct the point. Surely, this game will make the students be active because this game is fun and like competition for each teams. As the result, students will be able to master the material well. This research dealing with previous research by Stephen John Morrison (1998). Morrison stated that jeopardy game was lots of fun and the students could catch the material well. Once more, the classroom version of this game acts as a review to test the knowledge that students have learned during the course of unit, here the material is personal, possessive and reflexive pronoun.

F. Hypothesis

In conducting of this study, it is proposed the working hypothesis of the study can be formulated as “using jeopardy powerpoint game is effective for teaching personal, possessive and reflexive pronoun to the seventh grade students of SMP N 3 Purwokerto in the academic year of 2012/2013”.

THE EFFECTIVENESS OF JEOPARDY …… SHEILLIA OCTA ANGGRAENI, FKIP UMP 2013